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Organizing File Folders 

Windows 10 

 

  

 
As you use your computer and create files you may need some help in storing and retrieving 
those files.  This class shows you how to create, move, organize, search for, and delete files on 
your computer.  
  
  
Creating a File  
  
For this class we are going to create a file in Microsoft Word.  Open Word on the desktop.   
 

   
  
Type your name on the screen.  
  

 
 
   
  
When opening any program on the screen, there are three buttons in the upper right hand 
corner that may be of use to you. The first button will minimize the window so you can see your 
desktop. The second button will make the window either full screen or partial your screen size. 
The third button closes the program completely. 
 
 
 
 
 
 
 

1  2 

 

3 
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Saving a File to Documents  
  
After you type your name, click on the File Button, then on Save As, then on Browse. 
  

                                  
  
Because it is the first time you have saved this document the Save As box will open. In the left 
column, click on the word Documents. 
  

   
  
Your name should be in the File name box.  If you want to change the name of the document, 
just type – you don’t need to click in the box.  As long as the words are blue you can type right 
over them. Click Save. Then close the file. Your file will now be saved in the Documents folder 
(which is a folder on the hard drive of your computer).   

You should see 
your name here. 
If your name is 

here, Click Save. 
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Saving a File to the Desktop  
  
Click the File Explorer Icon on your taskbar, and then Documents  

 
   
 
 

 
 
In the Documents folder you should see the document you just created – look for your name.  
Double click the icon to open the file.  

                         
  
Click on File,  
then on Save As. 
The Save As window will open again.  Click on Desktop on the right.  If Desktop does not 
appear, click browse, then select Desktop from the left of the window. This changes where the 
computer will save the file. 
  

File Explorer 

Icon 
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 After switching to the Desktop, click Save.    
  
Close the file by clicking in the X in the upper right corner.  
  
   
 You should now see an icon for your file on the desktop of the 
computer.  
  
   
Different Views  
  
There are multiple ways to view the contents of a folder. The actual contents will not change, 
but the way you view those items will. 
 
Open the Documents folder from the File Explorer if not already open. You will see the 
contents of the folder displayed.  
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To change the view, click on the View tab from your ribbon. 
 
 

  
  
Choose another option from the list that appears. 
  
The options for icons are useful when viewing a folder 
full of images.  
 
Choose a few options from the list to see what 
happens. 
 
If you need to, maximize the window to see all the available information.  
  

   
 
In the Details view, you can sort the files by Name, Date, Size, etc. by clicking on the 
appropriate words at the top of the column.   
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Storage 
 
Storage devices allow you to save your files and take the information from computer to 

computer. 

Flash Drive 

A thumb drive, jump drive, flash drive, or USB drive will hold a large amount of data and is 

easily portable. It can hold between 128 MB and 4+ GB.  

 

 
External Hardware – Another icon you may run across in your system tray quite 
often is your external hardware icon. This icon only shown when you have a piece 
of external hardware plugged in. Examples include things like flash drives, digital 
cameras, external hard drives, etc. When it’s time to remove the device, it is 
recommended that you tell the computer to stop the connection with the device. 
That way your hardware isn’t damaged when you pull the device out.   
To stop the device, left click one time on the external hardware 
icon. Choose which device you would like to remove, and left 
click on it one time. (Flash drives are commonly called USB Mass 
Storage Devices.) You will be informed when it’s safe to remove 
the device from the system tray area.  
 
Cloud Storage 
 
“Cloud” storage means saving to a website that you have an account with. This will allow you to 
access your documents, photos, etc. from any computer after you have logged into the website 
with a username and password. You can access cloud storage through a desktop, laptop, smart 
phone, etc. Examples of cloud storage include websites such as Google, Dropbox, and 
Microsoft’s OneDrive (formerly known as SkyDrive). Most of these websites will give you so 
much free storage but if you need more then you can purchase it for a low cost. 

 
Measuring Storage 
What’s the difference between Megabytes and Gigabytes? 

 
1,024 Kilobytes (KB) = 1 Megabyte (MB) 
 1,024 Megabytes (MB) = 1Gigabyte (GB) 
1,024 Gigabytes (GB) = 1 Terabyte (TB) 
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Saving to a Flash Drive 
 
Double click on the icon for your document on the Desktop to open it. 
Click on the File Button, then on Save As, and then click Browse. 
 
   
 
 
 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the box on the left, find the item called This PC. Your flash drive should be listed here once 
you have inserted your flash drive.  (It may be called Removable Disk, Kingston, or the name 
of your flash drive’s manufacturer.)  

 
Click on the Save button and close the program. Your document is now on your flash drive. 
 
Accessing Different Drives. 
Now that you have a document saved on your flash drive, how do you access it? Click the File 
Explorer icon on your taskbar.  
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Your computer’s list of drives will appear.  

 You have a drive called Local Disk (C:),  
           which is where all of the information on  
           your computer is stored.  

 The DVD Drive (D:) is the part of your  
           computer that reads and writes to CDs and  
           DVDs.  

 Flash drives that you plug in will also be labeled with letters of the alphabet. Here, there 
are several plugged in (E:, F:, & G:). The bar below the drive lets you know how much 
used and free space there is.  

Double click on your flash drive icon to see what is saved on it. 
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Other Ways to Save to a Flash Drive 
 
Sometimes you would like to send items other than Word documents to your flash drive (folders, 
pictures, movies, etc.). 
 
Open the File Explorer 
window. 
 
Choose a folder or other item 
and right click on it. Point 
your mouse to Send to and 
left click on the name of your 
flash drive (i.e. Removable 
Disk). 
 
A copy of your item will be 
sent to your flash drive. The 
original one will stay in place 
on your computer.  
 
 
 Creating Folders 
  
In the Documents folder under 
the Home tab, click on New 
Folder. 
 
 
 
 
 
 
 
 
 
The computer will make a new folder for you.  
 
Type a name for the folder and hit the Enter key. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 



 Page 10 of 14 
Copyright 2018 ASCPL All rights reserved    Organizing Files Folders 3/31/2021   JM/DM 

Renaming Files  
  
To change a file’s name (but not its contents) right click on the file and select Rename.  
 
OR 
 
Click on the Home tab and choose Rename. 
  
 
The file name will change so that you can edit 
it.  Just type the new file name hit the Enter 

key.  
    
  
 
 
 
 
 

The name will change to whatever you type.  
 
Moving Documents into Folders  
  
Now that you have a new folder you can begin organizing your 
documents by placing them in the folder.  
Using the mouse, click on the document you wish to move.  Hold 
the mouse button down and drag the icon on top of the new 
folder icon.    
  
Let go of the mouse button and the computer will move that 
document into the folder.  
 
Open the folder to make sure your document has been moved successfully.  Double click the 
folder icon to see if your document is in that folder.   
 
  
Oops! I made a mistake. What do I do? 
 
The quick and easy way to undo a mistake is to press 
the Ctrl and Z keys at the same time. This will place 
your file back in its original location. Ctrl + Z is the 
shortcut for the undo function. If you can’t remember 
which keys to press, the undo function can be added 
to the quick access toolbar the top of the File 
Explorer window.  
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How do I move files into folders I can’t see? 
 
 
You can always cut and paste.  
 

 Left click on the file you wish to move so that it turns 

blue.  

 
 
 
 

 In the 

Home tab, Select Cut. (Select Copy if you 

wish to have two copies of the file instead of 

moving it.)  

 
 

 Navigate to the folder you wish to place your 

file in. Once you have opened that folder, click on the Paste option in the Home tab. 

 
Searching for Files  
  
To search the computer for a file, click 
on the Search Box on your taskbar, 
next to the Windows Icon.  From here, 
you can search for anything stored on 
your computer. 
   
Type the file name, if you know it, or 
search for a phrase that is in the file 
itself.  It will automatically search your 
computer and display results in the 
Start menu, itself, when you stop 
typing.  
   
The computer will find all the files that 
contain all or part of the file name.  In 
this case, it only found 1 document that 
included the name “mary” in the file 
name.  To open that document, click on 
it from the list.   
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Moving a File to the Recycle Bin  
  
If you no longer need a file you can move it to the 
Recycle Bin to get rid of it.  
  
From the Documents folder, click on the document 
you want to delete.  Then click on the Delete 
button on your Home tab in the ribbon, or press 
the Delete key on your keyboard. 
(Note: You must click the drop down arrow and 
click “show recycle confirmation” to get the 
warning message to delete files)  
  
 
The computer will check to be sure that this is what you want to do.  

  
   
  
 
 
 
If it is, click Yes.  
 
 
 
 
 
 

 
Note: Deleting files from a 
flash drive will permanently 
delete your files as it is 
indicated in the message box 
shown on the right. Your files 
will not be sent to the Recycle 
Bin. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Exploring the Recycle Bin  
  
If you need to see what files you have put into the Recycle Bin, simply double click on the 
Recycle Bin from your desktop to see its contents.  
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This box shows the contents of the Recycle Bin.  You should see the file you just deleted.  
 
 

   
 
 
Restoring Files from the Recycle Bin  
  
If you spot a file in the Recycle Bin that you do not want to permanently delete, click the file and 
select Restore this item under the Manage tab in the ribbon.  If you want to put all files back in 
their original place, click on Restore all items. The computer will put the item(s) back in the 
prior location.  
 
  
Emptying the Recycle Bin  
  
If you are sure you no longer need any of the files in the Recycle Bin, click on Empty the 
Recycle Bin.  Your files will be permanently deleted, so be sure you are ready to get rid of 
those files!  
  
 
Removing your Flash Drive 
 
It’s best not to just pull your flash drive out of your machine when you are done. That may 
damage the device. When you are finished using your flash drive and would like to remove it, 
first click on the device icon from your system tray. In our case, it is hiding. Click on the Up 
arrow to display hidden system tray icons. 
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In the window that appears, click on the device icon. 
 
 
 
Click on the device you would like to eject.  
 
 
 
 
 A message will appear, letting you know is it is 
safe to remove the device.  
 
 
 
 
 
 
   
 
 
 


